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1. UVOD

U posljednjih desetak godina Internet i Internet stranice postaju sve CeSce
koriSteni i sve utjecajniji mediji, bilo da se radi o edukaciji, istrazivanju,
oglasSavanju, trgovini ili jednostavno zabavi. Taj trend je kod nas malo manje
izrazen zbog ekonomske situacije u zemlji i relativno malog broja ljudi koji
poznaju barem osnove koristenja racunala, ali je u svijetu u naglom porastu i
vec je sad na vrlo visokoj razini.

Do toga je doslo poklapanjem raznih faktora, a ponajprije zbog izrazito brzog
razvoja racunalne tehnologije i smanjenja cijena racunalne opreme i usluga
ISP-a (Internet service provider — davatelj usluga koriStenja Interneta). Web
stranice su se u obliku slichom ovom danasnjem pocele razvijati 1992. god.
kad se pojavila prva verzija HTML-a (Hipertext Markup Language) koja se, za
pojmove racunalne industrije, relativno dugo razvijala. Jos je 1989. Timothy
Berners-Lee, Covjek kojeg zovu Otac Weba, podnio zahtjev (Proposal) u
kojem je trazio razvoj jednostavnog hipertekstualnog sucelja za razmjenu
informacija. Nakon dosta problema i odugovla¢enja zbog neslaganja oko
standarda 1992. je napokon objavljen prvi HTML standard, koji se kasnije
razvijao i mijenjao do danas. Ali osnovna sintaksa i elementi prve verzije
HTML-a je i danas vidljiva u svim jezicima koriStenim u danasnjoj izradi Web
stranica (joS uvijek se koriste hiperlinkovi, tagovi...). U samim pocecima
Interneta na Web stranicama je bilo vrlo malo multimedijalnih sadrzaja, i
uglavnom su se stranice sastojale od teksta i poneke slike. Napretkom
tehnologije i ubrzanjem veza smanjeno je vrijeme komunikacije Web servera i
browsera (aplikacija na raCunalu korisnika Interneta koja omogucava surfanje
Internetom) i ubrzan je prijenos podataka pa je i veli€¢ina same HTML
datoteke i dodataka (raznih slika, animacija i ostalih multimedijalnih dodataka
stranici) postala mnogo manje ograni¢ena. 1z samog HTML-a su se u
meduvremenu razvile daljnje verzije koje su pospjesile dinamiku i sam izgled
stranice i olakSale njezinu izradu.

U pocetku su se Web stranice izradivale izravnim pisanjem HTML koda, $to je
bilo dosta naporno i zahtijevalo je odlicno poznavanje programiranja i same
sintakse HTML-a. | danas neki webmasteri stranice izraduju "ru¢no" , sto za
prednost ima vecu kontrolu nad stranicom i njenim sadrzajem i manju HTML
datoteku, ¢ime je ubrzano ucitavanje stranice u Browser ali je sam postupak
dosta naporan i spor. Danas za izradu Web stranica postoje razni alati s tzv.
WYSIWYG (What You See Is What You Get) pristupom u kojima se stranica
ureduje vizualno slaganjem elemenata stranice, pri Cemu imamo pregled
stranice dok je jo$ radimo, dok se kod ru¢ne izrade stranica izgled stranice
kontrolira Cestim pregledavanjem u browseru Sto takoder usporava izradu.
Trenutno je vodecdi alat za izradu Web stranica Macromedia Dreamweawer
(posljednja je izasla verzija MX), a tvrtka Macromedia je i op¢enito vodeca u
proizvodnji Web alata i dodataka. U posljednje vrijeme se sve viSe koristi tzv.
Flash tehnologija, koja je takoder razvijena pod okriljiem Macromedie. To je
posebna vrsta multimedijalnog dodatka Web stranici u obliku animacije
izvedene u vektorskoj grafici i posebno optimiranog da bi bio podoban za
postavljanje na Web.

Kod nas je najdostupniji i najraSireniji alat za vizualno editiranje HTML-a
Microsoft FrontPage koji dolazi u paketu sa sveprisutnim Microsoft Officeom,
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pa Ce se u dijelu teksta koji prikazuje izradu Web stranica kao razvojni alat
uzeti bas FrontPage zbog svoje dostupnosti i lakSeg snhalaZzenja poCetnicima u
izradi Web stranica.

Ali, prije same izrade Web stranica moramo saznati neSto opcenito o
funkcioniranju samog Interneta, Web servera, nacina prijenosa podataka i,
naposljetku, same Internet stranice kao odredene skupine datoteka koje su
povezane kroz HTML kod u HTML datoteci.



2. INTERNET

2.1. POVIJEST INTERNETA

Internet je mreza koja se razvila na temeljima ARPANET-a (Advanced
Research Projects Agency), mreze koja je u poCetku povezivala raCunala na
americkim sveucilistima. 60-ih godina proslog stolje¢a ta je mreza izgradena
da bi povezala racunala na Stanford Research Institute in California,
University of California at Los Angeles (UCLA), University of California at
Santa Barbara (UCSB) i University of Utah. Mreza je prema zahtjevu
ameriCkih vojnih sluzbi izvedena tako da bi mogla funkcionirati ¢ak i ako bi
komunikacija s nekom od komponenata mreZe bila onemogucena (5to je bilo
vazno ako bi doSlo do atomskog rata — bilo je vrijeme Hladnog rata izmedu
SAD-a i SSSR-a). Ta mreza se je sve viSe Sirila | povezivala sve vise
sveucilista, pa je bilo neophodno uvesti fiksne standarde za razmjenu
informacija i protok podataka.

S vremenom su sve vece organizacije uvele svoje racunalne mreze u SAD-u i
u Europi, Sto je bilo vrlo prakticno i ubrzavalo je protok informacija, a pocCele
su se i stvarati prve online baze podataka. Tada je 1989. engleski racunalni
stru¢njak Timothy Berners-Lee zahtjev institutu CERN (European Center for
Nuclear Energy Research) da se razvije hipertekstualno sucelje za razmjenu
informacija, ¢ime bi se uvelike omogucila brza razmjena podataka i olakSala
daljnja standardizacija i razvoj racunalnih mreza. Isti taj stru¢njak je razvio i
WWW (World Wide Web) mrezu koja je povezivala racunala diliem svijeta,
koja je dio Interneta, a po koli€ini sadrzaja zauzima viSe od 75% sadrZaja na
cijelom Internetu, a istrazivanja pokazuju da taj udio Weba joS raste. World
Wide Web je 1989. donio mnoge standarde i rjieSenja koja su i danas aktualna
i omogucavaju funkcioniranje Weba i Interneta kao mreze.

2.2. DANASNJA PRIMJENA INTERNETA

lako je u pocCetku Internet bio namijenjen samo u znanstvene i poslovne svrhe
danas je Internet postao najveci svjetski medij za razmjenu informacija,
poslovanje, oglasavanje, komunikacije, zabavu i joS mnogo drugih primjena.
Razvija se ogromnom brzinom i niti najveci racunalni struénjaci ne mogu
predvidjeti njegove buduce primjene, a ni op¢enito smjernice njegova razvoja.
Danas su razvijene ogromne baze podataka koje su postavljene na Internetu i
vjeruje se da Internet sadrzi cjelokupno znanje Covje€anstva, $to je vjerojatno
vrlo blizu istine. Vrlo je malo stvari koje se ne mogu naéi na Internetu, i mada
su mnoge od njih zatvorene za pristup javnosti (kao npr. vojne informacije ili
strogo Cuvane tajne industrije) sve su te informacije postavljene na Internet da
bi bile lakSe i brZze dostupne. Neka istraZzivanja su pokazala da je oko 85%
sadrZaja na Internetu javno dostupno. Sto se ti¢e Interneta kao informacijskog
medija koji je sam po sebi daleko najveci i najopsezniji u svijetu, a jos je k
tome i velikom veéinom neovisan od cenzure nekih organizacija i vlada, on je
trenutno najbrzi i najpouzdaniji medij (viSe se ne postavlja pitanje da li neka
informacija postoji na Internetu, nego gdje ju je moguée pronadi).
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Multimedijalni sadrZaji na Internetu su sve brojniji i sve lakSe dostupni zbog
razvoja mreze i racunalne tehnologije koja postaje sve brza i jeftinija. Vrlo je
rasirena upotreba Interneta za komunikaciju u obliku E-maila, chata, raznih
video konferencija i slicnih oblika komunikacije.

2.3. NACIN FUNKCIONIRANJA INTERNETA

Internet je zasnovan na konceptu tzv. client-server relationship. Taj koncept
zapravo znaci da se jasno uocCava razlika izmedu servera (racunala koje daje
informacije ili podatke opcenito) i clienta (raCunala koje te informacije trazi).
Taj koncept je, ustvari, vrlo fleksibilan i ne znaci da su neka racunala
isklju€ivo serveri a druga iskljuCivo clienti. Bilo koje raCunalo moze biti i server
i client u odredenom trenutku, ovisno o tome da li to raCunalo "daje" podatke
ili ih prima od drugog racunala. Vazno je i naglasiti da odnos client-server nije
ograni¢en na samo dva raCunala, nego da jedan server moze opsluzivati
informacijama viSe racunala i da jedan client moze uzimati informacije s viSe
servera.

Da bi pristupilo informaciji na Internetu, raCunalo mora najprije biti spojeno na
mrezu (ili preko LAN-a ili preko modemske veze), zatim mora serveru koji
sadrzi odredenu informaciju poslati zahtjev za slanjem te informacije i tek tada
tu povratnu informaciju u obliku datoteke obraditi.

Kad u browser unesemo neku Internet adresu on tu adresu rastavi na vise
dijelova (protokol, ime servera i na ime trazene datoteke u najéesSéem
slu€aju). Zatim se browser spaja na tzv. name server na kojemu se nalazi
popis imena servera i njihovih IP adresa, i s dobivenom IP adresom
uspostavlja komunikaciju sa serverom dajuc¢i mu zahtjev za datotekom koju
trazi (tzv. GET request). Tada server u svojoj memoriji nade traZzenu datoteku
i Salje je natrag browseru u obliku paketa od kojih svaki ima broj koji mu
odreduje mjesto u toku podataka, €ime se osigurava cjelovitost podataka da
bi u slu€aju raznih smetnji raCunalo prepoznalo nedostatak dijela datoteke i
ponovilo svoj zahtjev za datotekom. Ovaj sustav komunikacije naziva se
TCP/IP (Transmission Control Protocol/Internet Protocol).

Racunalo koje je spojeno na Internet ima svoju jedinstvenu IP adresu koja
omogucava komunikaciju bez pogreSaka i usmjeravanja poruka ili podataka
na krivo racunalo. IP adresa se sastoji od Cetiri 32-bitna broja, tzv. okteta
(zbog toga $to mogu poprimiti vrijednosti od 2% = 256 vrijednosti). IP adrese
servera su staticne i ne mijenjaju se tako €esto kao IP adrese ra¢unala koja
se na Internet spajaju preko modemske veze. Njihove IP adrese se mijenjaju
svaki put kad se spoje na Internet, jer im ISP daje priviemenu adresu pri
spajanju ha njegove modemske ulaze.

Svaka Web stranica ima svoju adresu (URL-Uniform Resource Locator), koja
se sastoji od vise dijelova.

Primjer: http://encarta.msn.com/downloads/pryearbk.asp

http — oznaCava protokol koji je potrebno koristiti da bi pristupili toj adresi na
Internetu (u ovom slucaju Hipertext Transfer Protocol)

encarta.msn.com — oznacava tzv. hostname (ime racunala na kojem se
nalaze trazene datoteke)

downloads/pryearbk.asp — ostatak adrese oznaCava lokaciju na hard disku
servera. U ovom sluc€aju datoteka pryearbk.asp se nalazi u direktoriju
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downloads.
Ostale datoteke koje se nalaze u istom direktoriju ¢e imati slican URL, samo
Ce adresi na kraju biti promijenjeno ime datoteke.

2.4. WORLD WIDE WEB

World Wide Web je kao i cjelokupni Internet mreza medusobno povezanih
racunala koja komuniciraju i razmjenjuju podatke po odredenim standardima i
protokolima. World Wide Web je zapravo dio Interneta koji je daleko
najkoristeniji i najpoznatiji. Web je postao popularan odmah pri svom
pojavljivanju 1993. god. jer je omogucio pregledavanje slika i ostalih
multimedijalnih sadrzaja na relativno jednostavan nacin. Zbog toga vizualnog
koncepta sucelja Web je ubrzo postao mjesto na kojemu je moguce relativno
brzo i efikasno pronaci zeljene informacije.

Web dokumenti (stranice) se u principu sastoje od jedne tekstualne datoteke,
koja sadrzi sami tekst stranice u kojoj se nalaze informacije o tome kako je taj
tekst formatiran, gdje se na stranici nalaze multimedijalni dodaci (npr. slike), i
ostale informacije potrebne browseru da bi ispravno prikazao stranicu na
monitoru racunala. U pocCetku su se te tekstualne datoteke radile samo prema
HTML standardu, ali je kasniji razvoj doveo do uvodenja novih formata i
standarda, kako bi Web stranice postale vizualno bogatije, interaktivne i kako
bi im se opc¢enito povecale moguénosti prikaza podataka. lako se tim
razvojem daleko odmaklo od prvih verzija HTML-a joS uvijek je vidljiva veza
izmedu HTML-a i raznih danasnjih standarda. JoS i danas se u programskim
jezicima za izradu Web stranica kao osnova za formatiranje koriste tzv.
tagovi.

Tagovi su kodirane upute browseru kako da uobli¢i stranicu, kako izgleda
tekst stranice (boja, font teksta...), na kojem mjestu na stranici se nalaze
linkovi itd.

O kompatibilnosti svih standarda koji se koriste na World Wide Web-u brine
se ustanova nazvana World Wide Web Consortium (ili WWW Consortium, ili
W3 Consortium).



3. HTML

3.1. UVOD U HTML

HTML (Hipertext Markup Language) je prvi programski jezik koji je omogucio
izradu Web sadrzaja i koji je posluzio kao osnova svih danasnjih jezika za
izradu Web stranica. HTML je ustvari koncipiran na nacin da dijelove
dokumenta oznacavamo kao logic¢ke jedinice (npr: naslovi, poglavilja, liste,
tablice...). Ovakav koncept je omoguéio ogromnu fleksibilnost samog sustava
formatiranja i prikaza sadrzaja stranice, ovisno 0 moguc¢nostima racunala na
kojem se sadrzaj prikazuje. To je posebno dolazilo do izrazaja u ranijim
godinama razvoja Weba zbog toga Sto tada velik dio racunala nije mogao
prikazivati grafitke sadrzaje (slike, animacije i sl.).

HTML dokument je ustvari obi¢na tekstualna datoteka, koja je relativho
pregledna i na kojoj je u vecini slu€ajeva lako uociti glavne dijelove. Razlika
izmedu HTML dokumenta i obicnog tekstualnog dokumenta je u tzv.
tagovima, koji ¢ine osnovu sintakse HTML-a. Tagovi su od obi¢nog teksta u
dokumentu odijeljeni znakovima < i >.

Primjer:

<TITLE>Ovo je naslov stranice</TITLE>

|z ovog primjera se jasno vidi da tag <TITLE> oznaCava pocCetak naslova
dokumenta (Web stranice), a tag </TITLE> oznaCava zavrSetak naslova. U
HTML-u se nacelno razlikuju tzv. zatvoreni i otvoreni elementi. Zatvoreni
elementi (koji su mnogo €es&¢i) zahtijevaju osim pocetnog taga joS jedan
zavrsni tag koji se nalazi izmedu znakova </ i >. Otvoreni elementi ne
zahtijevaju zavrsni tag iz Cisto logickih razloga (jer ne sadrze nista, zato se
zovu jos i "prazni” elementi). Jedan primjer "praznog"” elementa je <BR> koji
oznacava prelazak na novu liniju na mjestu na kojem se u tekstu nalazi taj
tag. On je "prazan” jer ne sadrzi nikakav tekst u sebi, nego jednostavno daje
naredbu da nastavak teksta bude u novom redu.

Nekad se elementima pridruzuju atributi, koji su sli¢ni varijablama u
programiranju, i kojima se elementu dodjeljuje "vrijednost". Naj¢es¢i primjer
toga je uklju€ivanje slike u dokument.

Primjer:
<IMG SRC=""ime_slike.gif'">

Ovdje se vidi da je SRC atribut koji je pridruzen elementu IMG (eng.
Image=slika). U HTML sintaksi ne postoji razlika, ali je uobi¢ajeno da se
tagovi piSu velikim slovima radi preglednosti koda. Vazno je naglasiti da
razlika izmedu velikih i malih slova ipak postoji kod atributa koji se pridruzuje
elementu (dijelu teksta koji se nalazi izmedu navodnika). Bitno je i to da je
HTML strukturno ureden jezik i da je vrlo vazno postivati strukturu da bi HTML
kod bio ispravan.



3.2. PRIMJER HTML DOKUMENTA

Primjer jedne obi¢ne HTML stranice:

<HTML>
<TITLE>Ovo je ime stranice</TITLE>
</HEAD>
<BODY>
<H1>0vo je naslov stranice</H1>
<H2>0vo je podnaslov stranice 1 on je ispisan malo
manje uocCljivo</H2>

Ovo je obican tekst kojim se zeli pokazati da
Web browser sam formatira tekst, 1ako je u HTML
datoteci

sasvim razlicito oblikovan. Tekst mozemo
<STRONG>podebl jati</STRONG>,<EM>ispisati nagnuto</EM>
ili prebaciti u <BR>novi red. Mozemo ga cak i
razdvojiti horizontalnom <HR>linijom, Sto je korisno
kad Zelimo razdvojiti dijelove teksta bez upotrebe
tablice.

</BODY>
</HTML>

Ovakav tekst moZzemo napisati u bilo kojem tekstualnom editoru i spremiti ga
kao HTML dokument (npr: primjerl.html), dakle sa nastavkom .html ili .htm.
Takav dokument otvorimo nekom aplikacijom za pregledavanje Web stranica
(browserom), pri Cemu mozemo uociti da razli€iti browseri stranicu prikazuju
vrlo sli¢no, ili ak identi€no ako se radi o jednostavnijim primjerima. Slika 1
prikazuje kako ovaj primjer izgleda otvoren u browseru Opera 6.0.
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Slika 1 - Prikaz datoteke primjerl.html u browseru Opera 6.0

3.3. VIZUALNO EDITIRANJE HTML-a

Iz ovog jednostavnog primjera je vidljivo da je ru¢no pisanje HTML kdda
relativno spor i mukotrpan proces, koji jo$ zahtijeva i odli€no poznavanje
sintakse i svih ostalih pravila HTML-a. Zbog toga se je po€etnicima mnogo
lakSe orijentirati na alate koji omogucavaju vizualno editiranje HTML-a. Takvih
alata ima vrlo velik broj, ali ovdje ¢emo se skoncentrirati na kod nas
najdostupniji Microsoft Front Page. To je vrlo moéan alat, koji ima velike
mogucnosti editiranja HTML kdéda na osnovi WYSIWYG pristupa. Pruza nam i
mogucnost da ru€no editiramo dio kdda ako to iz nekog razloga Zelimo mada
u tom nacinu rada zaostaje za ostalim alatima iste klase, a pogotovo za
alatima koji su razvijeni bas za ru€no editiranje HTML-a. Njegova posebna
prednost je integracija s ostalim alatima iz Microsoft Office paketa (moguce je
provesti provjeru pravopisa, olakSano je konvertiranje dokumenata iz ostalih
Office alata u oblik podoban za postavljanje na Web...). U usporedbi sa nekim
drugim WYSIWYG alatima Front Page daje za isti sadrzaj stranice nesto vedi
HTML kdd Sto usporava prijenos stranice na Internetu i u€itavanje u racunalo
korisnika stranice. Ta razlika je relativno mala, pa to nije toliko bitno, ali to je
osnovni kriterij medusobne usporedbe kvalitete WYSIWYG alata jer se
kvalitetom i kompaktnosS¢u kéda mijeri kvaliteta nekog WYSIWYG web editora.
Za usporedbu ¢emo uzeti stranicu koja je izradena za primjer editiranja
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HTML-a u FrontPage-u (opisano kasnije u poglavlju 5.), a koja je izradena u
Macromedia Dreamweawer-u da bi se moglo usporediti kdd koji ta dva
programa generiraju za identi¢ni sadrzaj i nacin izrade stranice. Sami HTML
koédovi koji su oba dva programa generirala prebaceni su u Microsoft Word u
kojem su Word Count funkcijom dobiveni rezultati koje prikazuje slika 2:

Word Coun 1l 2]
Skatistics: =habstics:

Pages 4 Pages 3
yWords 591 Wiords Sas
Characters {ro spacesy 4,956 Characters (o spaces) 4,463
Characters (vath spaces) 6.778 Charackers [with spaces) 5,995
Psragraphs 123 Paragraphs in3
Lines 154 Lire= 128

™ Include Foctnotes and endniotes [ Indude fooknotes and endnotss

Micresoft FrontPagsa Macromedia Dreamweaawar

Slika 2 — usporedba kédova generiranih FrontPage-om i Macromedia Dreamweawer-om
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4. 1ZRADA WEB STRANICA

4.1. OSNOVNI PRINCIPI IZRADE WEB STRANICA

Danas, kada je Web postao jako rasiren i popularan medij, uobi€ajeno je da
svaka organizacija ili pojedinac koji zeli nekakav sadrzaj javno objaviti da to
ucini na webu. Razlozi za to su i viSe nego jasni: sadrzaju se moze lako i brzo
pristupiti, samo objavljivanje sadrzaja zahtijeva vrlo mala ulaganja, a
mogucnosti prezentacije sadrZaja su skoro neograniCene. Postavljanje Web
sitea na neki host server je besplatno ili se radi o zanemarivo malim
mjeseCnim naknadama, izrada Web stranica je postala jednostavna i takoder
relativno jeftina (osim ako se ne radi o profesionalnim webmasterima i
profesionalnim web stranicama, na €ijem razvoju Cesto rade timovi vrhunskih
struCnjaka i cijena takvih Web siteova zna biti nepojmljivo visoka za nase
uvjete).

Pri izradi Web siteova (skupa viSe tematski ili na neki drugi nacin povezanih
stranica) je preporudljivo drzati se nekih osnovnih principa da bi cijeli site bio
funkcionalniji i da bi navigacija po samom siteu bila jednostavnija za
posjetitelja koji se po prvi puta nalazi na njemu. Pri tome se misli na to da sve
stranice na siteu budu vizualno slicno koncipirane i da im raspored osnovnih
elemenata bude sli¢an (ili Cak isti) $to uvelike olakSava snalazenje posjetitelja
I ubrzava pronalazenje trazene informacije a i pozitivno se odrazava na
posjetiteljev opci dojam.

Ako se radi o opSirnijem Webu (sa viSe sadrzaja, i viSe podstranica) posebnu
paznju treba posvetiti organizaciji linkova za te podstranice da ne bi doslo do
toga da se na uvodnoj stranici nagomila veliki broj linkova, Sto bi bilo
nepregledno i zbunjujuée za posijetitelja. Ali pri tome treba paziti da se ne
pretjera u rasporedivanju linkova na podstranice kako se posijetitelju ne bi
nametnulo pet, Sest toCaka odluke jer to takoder otezava snalazenje pri
trazenju informacija.

Pri odrzavanju vizualnog koncepta konstantnim korisna je opcija koju
podrZzava vecina alata za editiranje Web stranica koja se u tim alatima naziva
CSS (cascading style sheet) i pomaze nam da jednom odredimo svojstva
nekih elemenata i da ta svojstva upotrijebimo na viSe Web stranica (npr. boja i
font linkova).

4.2. RASPORED ELEMENATA WEB STRANICE

Prema istrazivanju laboratorija SURL (Software Usability Research
Laboratory) posijetitelji Web stranica oekuju da se neki elementi stranice
pojavljuju na odredenim dijelovima stranice, pa je dobro obratiti paznju na to
da se (ako to nije u suprotnosti sa dizajnom stranice) postavi linkove na
odredena mjesta na stranici. IstraZivanja su pokazala da posijetitelji interne
linkove (dakle, linkove koji su povezani sa podstranicama sitea najceSce
oCekuju na lijevom rubu stranice, a eksterne linkove (koji vode na stranice
izvan naseg Weba) oCekuju na desnom rubu stranice, odnosno na lijevom
rubu ispod internih linkova. Link za povrat na naslovnu stranicu Weba (Home
Page) posjetitelji najéeSce oCekuju u gornjem desnom uglu ili na dnu stranice.
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Sve je to vidljivo na slikama 3 — 6 koje vizualno pokazuju na kojim podrucjima
stranice posjetitelji oCekuju koje elemente. Mada se na webu navigacijski
elementi najCesce i nalaze na lijevom rubu stranice gdje ih korisnici oCekuju
neka ergonomska istrazivanja pokazuju da bi smjesStaj uz desni rub bio bolji,
jer je tako lakSe pregledavati sami tekst stranice (Sto je ipak najvazniji dio
stranice).

FBudn by FeresdL iibond Egderer [Workng UTkies] __],E_Ii[
M rl S Faow Tatn o bes -
dmprh - =T a i_ﬂ i~ ﬁ:«qu | =1 =aatar .;-'_ll.w-\_. Lél' ) _'-.-: & |J
B o 3 PR e S ey e T R e |_| Sle

=l

E G l‘:' vk

Slika 3 - Graficki prikaz mjesta na stranici na kojem korisnici o€ekuju da se nalazi interni link
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Slika 5 - GrafiCki prikaz mjesta na stranici na kojem korisnici o¢ekuju da se nalazi link za
povratak na po€etnu stranicu
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Slika 6 - GrafiCki prikaz mjesta na stranici na kojem korisnici o€ekuju da se nalazi link za
pomoé

<5 | B-15 1625 |26-35|36-45 46.55(56. &5 66~ 75 | - 95

Tablica 1 — zajednicka legenda za slike 2 — 5 (istrazivanje SURL-a; brojevi znace postotke)

4.3. FONTOVI I CITLJIVOST STRANICE

Pri dizajniranju stranice potrebno je pripaziti i na izbor fontova koje ¢éemo
koristiti na stranici. Prvo ograni¢enje je sam izbor fontova koji se nalaze
instalirani na racunalima korisnika. Ako na stranicu postavimo font koji je
rijedak i ima ga relativno mali broj korisnika tada se naSe stranice na
raCunalima vecine korisnika nece prikazati onako kako smo zamisljali.
Browser pri u€itavanju stranice i njezinom formatiranju trazi u sustavu
instalirani font koji je specificiran u HTML dokumentu, a ako neki font nije
instaliran tada stranicu prikazuje u standardnom fontu Times New Roman
(default font). NajceS¢e se osim Timesa postavljaju fontovi Arial ili Tahoma.
Vazno je i razlikovati serifne i sans serifne fontove. Serifni fontovi (fontovi sa
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ukrasnim elementima na slovima), npr. Times New Roman imaju izrazeniji
pad Citljivosti sa smanjenjem veliine slova od sans serifnih fontova (npr. Arial
ili Tahoma), medutim ako je veli€ina slova veca od 12 toCaka tada raste
Citljivost serifnih fontova, Sto je vidljivo na slici 7.

290

280

270

260 \
T

250
240
230

12 tocaka 14 tocaka

=—fr=—serif ==P==sans serif

Slika 7 — Brzina Citanja teksta ovisno o ukrasima i veli€ini samoga teksta

Preporu€a se da fontovi tekstova koji su veli€ine 12 toCaka ili manje budu
sans serifni zbog svoje Citljivosti. Posebno do izrazaja dolazi pad Citljivosti
serifnih fontova koji su smjesteni na teksturirane podloge (tekstovi koji u
pozadini imaju neku sliku). Ista istraZivanja su pokazala da korisnici
subjektivno vise vole Arial ili Tahomu od Timesa.

4.4. JOS NEKE SMJERNICE ZA IZRADU WEB-a

Da bi se izbjegle zabune i dezorijentacija korisnika stranice dobro se je drzati
jos nekih "nepisanih” pravila. Vazno je obratiti paznju na naslov stranice. Koji
mora biti jasan i po moguénosti zapocinjati sa kljuénom rijeCi zbog toga Sto
korisnici postavljaju Favorites listu (listu stranica koje ¢esto posjeéuju)
azuriraju po abecedi, pa se time izbjegavaju zabune. Treba izbjegavati
podcrtavanje teksta koji ne sluzi kao link, jer veéina browsera automatski
podcrtava linkove. Posebnu paznju pri samoj izradi i azuriranju stranica treba
obratiti na linkove koji moraju biti funkcionalni (ne smije biti "mrtvih" linkova,
dakle treba paziti da se ciljevi linkova to¢no upiSu i da stranice na koje
upucuiju ti linkovi doista postoje). Pokazalo se da korisnici ne vole tzv. uvodne
stranice (stranica na kojoj je jedini sadrzaj link tipa "klikni ovdje ako Zeli$§ udi
na Web stranice ..."), to je samo po sebi nelogi¢no jer nitko ne bi ni dolazio
na nasu pocetnu stranicu ako ne bi Zelio posijetiti nas Web. Na stranice je
dobro postaviti i neki oblik servisnih informacija (E-mail adresa webmastera ili
nekih drugih ljudi koji su na neki nacin povezani sa sadrzajem samih stranica)
i datum kada je sadrzaj stranice posljedn;ji put azuriran (Sto je posebno vazno
ako su osnovni sadrzaj nekakve vijesti).
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4.5. NAPREDNE TEHNOLOGIJE NA WWW-u

Zbog stalne potrebe za vizualnim i sadrzajnim unapredivanjem weba stalno
se razvijaju nove tehnologije koje web stranice €ine dinamicnijima i
interaktivnima s korisnikom. U pocetku je taj razvoj iSao tako da se raznim
izmjenama i dopunama HTML standarda povec¢avalo mogucnosti web
stranica, a kasnije su se pocele razvijati i razne skripte i skriptni jezici.

Tako je, na primjer razvijen DHTML (Dynamic HTML) koji je zapravo obi¢ni
HTML obogacen raznim skriptama koje €ine stranicu dinamicnijom i
interaktivnom sa surferom. Ta dinami¢nost je omogucéena skriptnim jezicima
poput JavaScript-a ili CSS definicijama.

Razvijen je i XML (eXtensible Markup Language), koji je postao vrlo
popularan jer je proSiriv. Po samoj sintaksi je slican HTML-u, samo Sto se za
razliku od HTML-a u kojem su znacenja tagova definirana u XML-u znacenja
tagova definira webmaster Sto mu daje veliku fleksibilnost. JoS jedna velika
prednost XML-a je u tome $to je on kao i HTML ustvari Cisti tekst, tako da je
Citljiv na svim platformama. Kao jezik je strukturiran i postoji tocno definirana
hijerarhija a sluzi za spremanje raznih oblika podataka i omogucuje njihovo
lako i brzo Citanje zbog tocno odredene strukture informacija.

XHTML (eXtensible Hypertext Markup Language) je zapravo nastao
reformuliranjem HTML 4.01 standarda prema XML-u. U XHTML-u svi tagovi iz
HTML-a nastavljaju postojati, ali se u skladu sa XML-om mogu dodati i novi
elementi i atributi. XHTML slijedi sva pravila XML-a — svi tagovi moraju imati
zavrsni tag, tagovi se medusobno ne smiju preklapati, atributi se obavezno
stavljaju u navodnike...

Za potrebe baza podataka razvijen je PERL (Practical Extraction and
Reporting Language), skriptni jezik €ija je sintaksa slicna C-u. Koristi se pri
izradi CGl (standardni nacin kojim web server Salje zahtjev korisnika nekoj
aplikaciji i vraca generirane podatke korisniku) programa jer ima odli¢an rad s
tekstom i bazama podataka.

ASP (Active Server Pages) su zapravo obi¢ne HTML stranice obogacene
skriptama koje se izvrSavaju na serveru prije nego se stranica posalje
korisniku. ASP stranice se najceSce koriste pri izradi stranica koje se
povezuju na bazu podataka (npr. Acess ili SQL server). Njegova je prednost
Sto se stranice obraduju na serveru, a korisniku se Salje Cisti HTML kéd pa
nema problema sa prikazivanjem u bilo kojem browseru.

Kao alternativa ASP-u koji radi samo na serverima koji rade na Windows
platformama razvio se PHP, koji je primarno razvijen da bi se koristio na Linux
platformama ali se moze prilagoditi i radu na Windows platformi. PHP je
besplatan skriptni jezik i interpreter. Takoder kao ASP obraduje potrebne
podatke na serveru i korisniku Salje Cisti HTML kéd. Njegova snaga je u
velikom broju ugradenih funkcija, od onih za direktno generiranje slika ili PDF
dokumenata, pa do otvaranja datoteka na drugim serverima.

JSP (Java Server Page) je takoder tehnologija za serversko odredivanje
izgleda web stranica upotrebom "servleta" (malih aplikacija koje se pokrec¢u
na samom serveru i generiraju web stranicu prije nego se sa servera posalje
korisniku.

JavaScript je klijentski skriptni jezik koji se izvrSava na u korisnikovu
browseru. Pruza upotrebu raznih efekata na stranici kao 5to su rollover efekt
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ili provjera unesenih podataka, pa €ak i izmjene sadrzaja samih elemenata
stranice, ovisno o interakciji s korisnikom.

U novije vrijeme webmasteri izbjegavaju upotrebu Jave zbog toga Sto u novim
Windowsima XP i u samom browseru Internet Explorer verzije 6 ne dolazi
podrsSka za Javu, pa se pri nailasku na stranice sa sadrZzajem koji trazi Javu
nudi download paketa za podrsku Javi Sto korisnike odbija od pregledavanja
takvih stranica. Razlozi za nepodrZzavanje Jave u novim proizvodima
Microsofta leZe u, prema mnogima ¢udnoj poslovnoj politici tvrtke Sun (tvrtke
koja je razvila Javu) i koja je sudskim sporom protiv Microsofta izazvala to da
velika vecCina korisnika (koji imaju Microsoftov novi Internet Explorer) ne moze
pregledavati stranice izradene u Javi, $to je uzrokovalo veliki pad popularnosti
Jave.
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5. IZRADA WEB STRANICA U FRONT PAGE-u

5.1. UVOD U IZRADU STRANICA

U ovom poglavlju c¢emo pokazati kako jednostavno izraditi jednostavan, a ipak
atraktivan web site koji ¢e sadrzavati osnovne elemente koje je kao pocetnik
potrebno poznavati da bi se izradila jednostavna i funkcionalna web stranica
ili web site. Posto je suCelje Front Page-a sli¢no sucelju Worda ili Excela novi
korisnici najceS¢e nemaju problema sa prilagodbom, posto vecina ve¢ ima
iskustva u radu sa tim alatima (koji su trenutno osnova racunalne pismenosti i
najkoridtenije aplikacije opéenito). Kao temelj dizajna ¢e nam posluZiti tablice
pomocu kojih ¢emo najlakSe rasporediti elemente stranice (Sto je najCeSca
metoda koja se trenutno koristi za "layout" stranice). U primjeru ¢e biti
prikazana izrada jednog malog web sitea (od osam stranica). Da bi nam sve
stranice izgledale sli¢no i o€uvale nekakvu stalnost sto se tiCe rasporeda
elemenata i samog izgleda koristit cemo tzv. "template" koji cemo sami
izraditi. Postoji i naprednija metoda za oCuvanje rasporeda i izgleda stranice
kroz CSS definicije, ali to je dosta slozena metoda i poc€etnici se u njoj Cesto
izgube. Posto se ovim primjerom zeli po€etniku pribliziti izrada web stranice
pomocu alata za vizualno editiranje HTML kéda (ili nekog drugog, ovisno o
tome koji jezik koristimo) stranice koje ¢e biti koriStene kao primjer ¢e biti
relativno jednostavne i naglasak ce biti stavljen na izradu same stranice, a
grafiCka priprema slika koje ¢e biti umetnute nece biti posebno objasnjavana.

5.2. IZRADA "TEMPLATE" STRANICE

Da bi ubrzali i olakSali postupak izrade stranica koristit cemo tzv. template
(podloga koju ¢emo samu napraviti i koju ¢emo koristiti da bi lakSe izradili
ostale stranice).

Kada pokrenemo Front Page kliknemo na padajudi izbornik File>New>Web, i
u izborniku koji nam se ponudi izaberemo Empty Web i na desnoj strani
izbornika upiSemo lokaciju na hard disku na kojoj zelimo spremiti datoteke
koje Ce generirati Front Page i kliknemo na OK. Nakon toga opet kliknemo na
padajuci izbornik File>New>Page i tu u tabu General izaberemo New Page.
Tada kliknemo desnom tipkom miSa negdje na praznu stranicu i izaberemo
Page Properties i u prozoru koji smo dobili u izborniku Language postavimo
Page Language na Croatian, a HTML encoding na Central European. Nakon
toga ¢emo opet kliknuti desnom tipkom miSa negdje na praznu stranicu i
izabrati Font. U tom prozoru ¢emo izabrati font za svoje stranice (izabrat
¢emo Arial, a ostale postavke ne¢emo mijenjati). Sada ¢emo dosadasnje
postavke spremiti u padaju¢em izborniku File>Save As gdje ¢emo pod File
Name upisati podloga, a u izborniku Save As Type ¢emo postaviti FrontPage
Template. Nakon toga se pojavljuje joS jedan prozor na kojem samo stisnemo
OK (u njemu mozemo unijeti naslov podloge i upisati svoj komentar, ali to
nam nije bitno).

Sada ¢emo na na$oj podlozi napraviti tablicu preko izbornika
Table>Insert>Table, nakon ¢ega ¢e se pojaviti prozor u kojemu ¢emo
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vrijednosti postaviti kao na slici 8. Za poCetak ¢emo napraviti tablicu sa dva
retka i jednim stupcem. U jednom retku ¢e nam biti sliCice koje Ce sluziti kao
linkovi na ostale podstranice weba, a u donjem dijelu tablice ¢e se nalaziti
sadrzaj stranice. Ako zelimo da nam tablica bude vidljiva i u browseru, tada
¢emo border size postaviti na 1 ili 2 toCke, i time ¢emo Koristeci tablicu dobiti
fine granice izmedu dijelova stranice (Sto se dosta Cesto koristi).

Insert Table i ilil
Size
R owe; 2 — Columnz: 1 =
L anout

Alignment: IEenter vI ¥ Specify width:
Border size; IEI __Ij |‘||:||:| " In pixels

% |n percent

Cell padding: 0 —

Cell spacing: 0 —

Style. .. | k. I Cancel

Slika 8 — Umetanje osnovne tablice

Zatim ¢emo kliknuti desnom tipkom misa negdje na tablicu i izabrati Table
Properties u kojima ¢emo namjestiti Sirinu tablice na 750 toCaka, a visinu na
100% kao na slici 9. Ovo dimenzioniranje tablice je vrlo bitno za konacni
izgled stranice jer pomocu ove tablice u kojoj Ce se nalaziti svi elementi
stranice to&no definiramo veli¢inu nase stranice. Sirina od 750 togaka je
vazna zato $to je trenutno na raCunalima najraSirenija razluc€ivost od 800x600
toCaka, a visina se namjesta na 100% da bi se tablica automatski
reformatirala (produzavala) ovisno o koli€ini sadrzaja.
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Layout
Aligriment; IEenter j ¥ Specify width:
Flaat: IDefauIt j |?5|:| ﬁ In piels
I percent
Cell padding: IEI E: ¥ Specify height:
Cell zpacing: ID 3: |-||:||:| " In pisels
' |n percent
Borders
Size IEI Eﬁ Light barder: I- Aukarnatic j
Colar. I MW Autornatic j Dark border: I W Automatic j
B ackground
Color: I [ | automatic j
[ Use background picture
I Browze. . | Froperties... |
Style... | ()% I Cancel | Apply |

5.3. SLIKA 9 - POSTAVKE OSNOVNE TABLICE

Sad ¢emo formatirati gornji dio tablice na visinu od 100 toCaka, a Sirinu
¢emo ostaviti definiranu kroz samu Sirinu tablice. to éemo napraviti tako da
desnom tipkom miSa kliknemo u samu Celiju tablice i odaberemo Cell
Properties. Tu ¢emo postaviti vrijednosti kao $to je prikazano na slici 10.
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L apaut

Harizontal alignment: I Drefault - I [ Specify width:
Yertical alignmant: IDefauIt -I I £ | pivels

% |1 percent
Flows spanned: 1 - ¥ Specity height:
Colurnns spanned: I'I 3: I1 oo & In pivels
" In percent
[™ Header cell
[T Mo wrap
Borders
Calor: I B Automatic j Light border: I B Automnatic Ll
Drark border: I B :utomatic j
B ackaground
Calor: I W :Automatic ;I
[T Usze background picture
I Browsze. . I Properties. . |

Style. .. | k. I Cancel | Apply i

Slika 10 — namjestanje visine gornje ¢elije tablice

U tu €eliju éemo smjestiti novu tablicu sa sedam stupaca i jednim
retkom na isti nacin kao Sto smo unijeli i prvu tablicu. Nakon Sto je unesemo
njezinu visinu i Sirinu ¢emo postaviti na 100% (tih 100% se odnosi na visinu,
odnosno Sirinu Celije u koju je tablica smjesStena). Sada ¢emo u svaku od tih
sedam celija unijeti po jednu sliku. To ¢emo u€initi kroz padajuci izbornik
Insert>Picture>From File. Tada ¢e nam se otvoriti prozor (slika 11) koji trazi
od nas da specificiramo lokaciju na kojoj se na naSem hard disku nalazi slika
koju zelimo umetnuti. Najbolje je prije umetanja prve slike sve slike koje
namjeravamo koristiti na nasoj web stranici spremiti u poddirektorij images u
direktoriju _Web u koji je FrontPage ve¢ spremio nasu stranicu. Tako ¢e se
izbjeci problemi sa lokacijom slika ako budemo mijenjali lokaciju nasih
stranica na hard disku (ili ih prenesemo na drugo ra¢unalo), jer éemo tada sa
samim stranicama prenijeti i slike koje one sadrze. Tada do problema sa
lokacijom slika nece dolaziti jer FrontPage sprema relativnu stazu do slika
(dakle, specificira samo lokaciju slika u direktoriju _Web bez obzira gdje se taj
direktorij nalazi).
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Marne | Title il

ﬂ 01piramide. jpg images /01 piramide. jpg
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@DShalikﬂrnas.jpg images /0Shalikarnas.jpg

@Dﬁknlns.jpg images/06kolos.jpg

@D?Farus.jpg images|07faros,jpg

@ 1piramide. jpg images| 1 piramide, jpg

EESEmiramida.jpg images/2semiramida. jpg

[H]=01e inn imanes reis inn b

< | LIJ
JRL: Iimagesx’l:l'l piramide. jpg j gl @l

] I Cancel Clip Art.... Farameters. .. | Scan... |

Slika 11 — odabir slike koju umeéemo na stranicu

Nakon $to umetnemo slike koje ¢e nam sluziti kao linkovi moramo
svakog od njih povezati sa stranicom na koju nas vodi. To ¢emo napraviti tako
da ¢emo oznaciti sliku za koju Zelimo postaviti hyperlink i onda nakon desnog
klika miSem na nju odabrati Hyperlink. Tada nam se pojavljuje prozor u kojem
moramo oznaciti na koju stranicu vodi taj na$ hyperlink. Posto jo§ nismo
napravili niti jednu stranicu na koju bi vodio moramo upisati ime te stranice
kao na slici 12. Ovo nam je mnogo lakSe sada napraviti na podlozi nego to
raditi pojedinacno na svakoj stranici ili kopirati linkove na svaku stranicu. Zato
je sada vazno odmah odrediti imena ostalih stranica da bi za njih lakSe
postavili linkove koji ¢e ih povezivati na druge stranice u naSem webu.
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index.htm Sedam svjetskib cuda
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Cltemp
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Slika 12 — postavljanje linka na drugu stranicu

Vrlo je vazno da specificiramo da se stranica na koju vodi link nalazi u
istom direktoriju kao i po€etna stranica (opet zbog spremanija relativnih staza
do datoteka). Nakon $to za sve sli€ice s vrha stranice postavimo linkove
moZemo nastaviti sa kreiranjem ostalog dijela stranice.

U donju celiju glavne tablice cemo umetnuti novu tablicu sa dva retka i
tri stupca. Na isti nacin kao i prije éemo namijestiti lijevi i desni stupac (ne i
sredniji) na Sirinu od 150 toCaka. Cijeli donji redak ¢emo namjestiti na visinu
od 20 toCaka. Taj redak nam sluzi za umetanje linka za povrat na poc¢etnu
stranicu i za dodavanje kontakta (najceSce za osobu koja izraduje ili odrzava
stranice). Lijevi dio stranice ¢e nam sluZiti za unutarnje linkove (iako smo ih
vec postavili kao slike na vrhu stranice postavit cemo ih jo$ jednom kao
klasi¢ne linkove, radi vjezbe). Ovi klasi¢ni linkovi se jednostavno unose kao
obi€an tekst u celiju tablice, a zatim se oznacCe i, opet kao i prije nakon
desnog klika miSem na oznaceni tekst odabrati Hyperlink. Za cilj linka opet
upiSemo ime datoteke na koju vodi link. Tu proceduru ¢emo ponoviti i u
desnoj Celiji tablice, samo $to nam se tu nalaze eksterni linkovi (koji vode na
stranice koje se nalaze izvan naSeg weba, dakle na Internetu), pa se tu
umjesto imena datoteke mora upisati njena cjelokupna Internet adresa, npr.
http://pharos.bu.edu/wonders/. U te Celije u kojima nam se nalaze linkovi
¢emo postaviti i slike (koje se sada za razliku od onih prije linkova postavljaju
kao pozadinske slike). To ¢emo uciniti tako da desnim klikom miSem na ¢éeliju
tablice odaberemo Cell Properties i u prozoru koji se pojavi (slika 13)
oznacimo "checkbox" Use background picture i pomoc¢u gumba Browse
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dodemo do slike koju umecemo. Pri tome je vazno znati da ¢e se pri umetanju
pozadinske slike u Celiju tablice u slu€aju da je ta slika manja od raspolozivog
mjesta u Celiji sama slika ponavljati sve dok ne ispuni raspolozivi prostor (sto
je vrlo korisno za izradu nekih tekstura jer se napravi samo jedan segment
koji ¢e se stalno ponavljati, Cime se automatski smanjuje veli€ina datoteke
slike koja se koristi za tu teksturu). Da se to ne bi dogodilo i u ovom slucaju
(da se ispod postojeéeg stupa doda jos dio stupa do ¢ega bi doslo ako bi se
stranica izduzila) koristi se vrlo jednostavan trik: slika se sastoji od samog
stupa i ispod njega Cistog bijelog prostora koji je dosta izduzen. U jpeg
formatu slike taj dodatni bijeli dio zauzima vrlo malo od ukupne veli€ine slike
iako je samo to bijelo podru¢je mnogo vece od ostatka slike.
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Slika 13 — umetanje pozadinske slike u ¢eliju tablice

U sredisnjoj Celiji ove tablice cemo kasnije smjestiti sadrzaj stranica, pa
¢emo u njoj sada formatirati tekst kako bi kasnije izbjegli razliite veliCine
slova izmedu stranica. Takoder cemo taj tekst centrirati na sredinu celije. Da
bismo mogli definirati tekst koji ¢emo kasnije unositi moramo upisati barem
naslov i jedan redak obi¢nog teksta. Tada ¢emo oznaciti naslov i definirati da
pripada elementu Heading 1 (u HTML-u se veli€ina slova ne formatira kao u
obi¢nim tekstualnim editorima kroz visinu slova u to¢kama nego se za dijelove
teksta zada kojem elementu pripadaju, a browser ih prema tome formatira na
odgovarajucu veli¢inu). Za tekst ¢emo ostaviti atribut Normal. Ustvari bi se
veli€ina slova teksta stranice mogla definirati kroz CSS, ali tada sam browser
ne bi mogao samostalno formatirati tekst (prema Zelji korisnika, jer svaki
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browser pruza korisniku mogucénost da odabere izmedu nekoliko veli€ina
teksta sto CSS onemogucuje).

Nakon Sto smo u podlogu unijeli sve zajedniCke elemente svih stranica
ponovo ¢emo spremiti naSu podlogu na kojoj éemo bazirati razvoj nasih
stranica. Sada ta podloga sadrZzava sve naSe postavke koje smo napravili na
njoj, od jezika i fonta stranice do tablica, slika i linkova na njoj.

5.4. IZRADA WEB STRANICA POMOCU GOTOVE PODLOGE

Sada ¢emo pomocu podloge koju smo napravili izraditi sve stranice naseg
web sitea. Pomocu te podloge je definiran izgled nasih stranica, pa samo
moramo unijeti sadrzaj pojedinih stranica u sredisnju Celiju tablice. Prvo ¢emo
izraditi poCetnu stranicu, koju moramo nazvati index.htm (ili index.html — to je
ustvari isti format, samo Sto je ranije na PC platformi za ekstenziju u imenu
datoteke bilo dozvoljeno samo tri znaka pa je sad moguce koristiti obje
ekstenzije bez ikakve razlike). PoCetna stranica svakog weba naziva se
index.(odgovarajuéa ekstenzija) zbog toga $to ¢emo tako postici da korisnik
koji upiSe nas URL automatski dobije poCetnu stranicu.

|z padajuceg izbornika File>New>Page ¢emo dobiti prozor u kojem ¢ée se
nalaziti nasa podloga, koju ¢emo izabrati i klikom na OK dobiti podlogu. Sada
jednostavno umjesto teksta koji smo upisali u sredi$nju Celiju stranice
unosimo sami sadrzaj stranice. Jos je vrlo vazno da gotove stranice
spremamo u onaj direktorij koji je kreirao FrontPage (_Web), i to kao Web
Pages Sto sam FrontPage automatski namjeSta. Prvu stranicu naseg weba
moramo nazvati index.htm, a ostale prema Zzelji (ali u naSem slucaju je vazno
postivati imena stranica koja smo definirali kad smo za njih postavili linkove
da bi ti linkovi stvarno vodili na te stranice).

Nakon Sto smo izradili sve stranice weba mozemo vrlo jednostavno provjeriti
povezanost linkova koje smo postavili na nasu stranicu kroz padajuci izbornik
View>Hyperlinks, ¢ime ¢emo dobiti popis svih datoteka naSeg weba a
odabirom pojedinih datoteka Ce se prikazati linkovi koji sa te datoteke vode na
neku drugu stranicu i linkovi koji na pojedine stranice vode sa drugih stranica
weba. Kroz padajudi izbornik View>Reports>Site Summary mozemo pogledati
joS mnogo podataka o naSem webu (ne samo o stranicama, nego i 0 slikama i
0 eventualnim drugima vrstama datoteka).

5.5. PROVJERA IZGLEDA STRANICE U RAZNIM
BROWSERIMA

Prije nego Sto stranicu "uploadamo” na server i izlozimo u javnost moramo je
prekontrolirati u browseru. Zapravo, u Sto viSe razliCitih browsera jer medu
njima postoje dosta velike razlike iako su svi browseri iste generacije radeni
po istim standardima.
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Slika 14 — Izgled stranice otvorene u browseru Mozilla verzija 1.0 (nasljednik Netscape
Navigatora)

Zbog prostornih ograni€¢enja necemo postaviti slike stranice u svim
browserima nego samo u Mozilla 1.0 browseru (slika 14), jer je prikaz stranica
identi¢an u ostalim browserima (radi se o obi¢nim, vrlo jednostavnim HTML
stranicama tako da do razlika interpretacije HTML kéda ne moze dodi). Jedino
se mogu razlikovati boje prikaza linkova ili nekih drugih elemenata od
browsera do browsera, iako ovdje ni to nije slucaj.

Ako server na koji Zelimo postaviti svoje web stranice radi na Windows
operativhom sustavu, tada vjerojatno ima i instaliran FrontPage Server
Extensions koji nam omogucava da izravno iz FrontPagea uploadamo svoje
web stranice na server. U slu€aju da nema morat ¢emo se posluziti nekim
drugim programom koji je specijaliziran za to (npr. WS_FTP Pro ili Site
Publisher).

5.6. ZAKLJUCAK

Nakon predenog 5. poglavlja koje je ustvari vodi€ za izradu stranica u
FrontPage-u koji pokazuje osnove kreiranja web stranica znamo osnove
organiziranja i izrade web stranica, i sada samo treba malo rada i vjezbe kako
bi se mogao izraditi osobni web. Nazalost zbog ograniCenja mjesta nije bilo
moguce prikazati i osnove grafiCke obrade slika bez kojih je nemoguce
napraviti web stranicu na razini danasnjih. Zapravo je vazno samo znati

26



osnove kao sto su promjena veliCine slike, namjestanje boja i kontrasta slike,
spajanje nekoliko slika u jednu...

Sada tehnike prikazane u ovom vodi¢u samo treba koristiti da bi se usavrsilo
znanje, a to je najbolje Ciniti kroz eksperimentiranje jer tako potiCemo svoju
kreativnost, a kreativnost je najvaznija za izradu weba. Moja preporuka je da
se pridrzava dizajna koji se oslanja na tablice, jer se tako mnogo stvari
olakSava i pojednostavljuje a HTML i drugi jezici za izradu weba nemaju
nikakvih problema s radom tablica, i umetanje tablica u tablicu je standardni i
vrlo Cest postupak izrade weba.

Sto se tige priloga stranici kao $to su slike, animacije i sl. treba biti umjeren i
ne postavljati previSe takvog sadrzaja, a onaj koji se postavi treba biti u
formatima koji omogucavaju dobru kompresiju (npr. za slike se danas
vecinom koriste gif i jpeg formati koji imaju odli€cnu kompresiju, a vec¢ se Siri i
primjena formata JP2 (jpeg2000) koji uz pomo¢ novih algoritama kompresije
jos vise povecCava omijer kvalitete slike i veli€ine datoteke), a dobro je i
dodatno smanijiti veliCinu slike smanjenjem broja boja same slike kad je to
moguée uéiniti. Sto se ti¢e dizajna samih stranica najbolje je u po&etku
pogledati veliki broj stranica i uociti elemente dizajna koji podizu kvalitetu
stranice i inspirirati se takvim primjerima. Naravno, u tome treba biti umjeren i
ne kopirati tude radove ili ako vec Zelimo na svoju stranicu postaviti neku
animaciju (npr. flash) koju je netko drugi napravio tada bi bilo dobro
kontaktirati autora da bi dobili odobrenje (koje naj¢eSc¢e i dobijemo, samo s
uvjetom da na svoju stranicu postavimo i link koji ¢e voditi i na stranicu
autora).

Sve u svemu, uCenje iizrada web stranica je zanimljivo pa se sa malo
vremena i volje sve to moze nauciti u 5-6 dana ako se netko ne misli time
profesionalno baviti. Nadam se da ¢e ovaj vodi¢ nekome pomoci da nauci
izradivati web, Sto je danas vrlo trazen i u nekim slucajevima vrlo dobro
placen posao.
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